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Electrode Machining
Wizard

The Electrode Machining Wizard is a PowerMill plugin.

You can use the wizard to extract the information from a .trode file
and select the tooling and toolpaths to machine the electrode. You
can then reuse the settings to automate future electrode machining
projects.

The Electrode Machining Wizard automatically detects the electrodes
to machine and applies the correct undersizes to the toolpaths.

Electrodes are machined undersize to make allowance for an
appropriate spark gap and orbit on the Electric discharge machine
(EDM).

In the EDM industry, the terms spark gap and overburn are often
used interchangeably with undersize.

O T®

@ Undersize
@ Spark gap
@ Electrode
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@ The material to be removed

To calculate thicknesses, the undersize is subtracted from the
machining allowance.

So, Thickness = Machining Allowance - Undersize.

When creating toolpath templates, only include machining
allowances in your calculations as the appropriate undersize is
applied by the Electrode Machining Wizard and is different for each
electrode.

A .trode file exported from PowerShape's Electrode Design Wizard
contains the following information:

= The geometry for the electrode.
= The material type and block size.
= The spark gaps/undersizes.

The Electrode Machining Wizard analyses this information and
displays the geometry in various colours.

Regions are represented as:

Burn region
Extension
Clearance
Base
Frame

e
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See also

Installing the Electrode Machining Wizard (see page 4)

Installing the Electrode Machining Wizard examples (see page 5)
Using the Electrode Machining Wizard (see page 6)

Configuring the Electrode Machining Wizard (see page 19)
Electrode Machining Wizard options (see page 22)
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Installing the Electrode Machining
Wizard

The default installation folder is:
C:\Program Files\Autodesk\ElectrodeMachiningWizardxxxxx
Within the installation folder, the Data folder contains:

* Tools — This folder contains the default machine tools available
with the wizard.

= Strategies — The folder contains the default strategies available
with the wizard.

Use the options available under PowerMill > File tab > Options >
Manage Installed Plugins > Electrode Wizard > Options (see page 22)
to change the default data folder.

—% - If you install Electrode Machining Wizard Examples, the

default Data folder path changes to the folder available in the
Electrode Machining Wizard Examples install folder.
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Installing Electrode Machining Wizard
examples

The default folder where Electrode Machining Wizard examples are
installed is:

C:\Program Files\Autodesk\ElectrodeMachiningExamplesxxxxx

xxxxx denotes the Electrode Machining Wizard examples version
number.

The folders within the Electrode Machining Wizard examples
installation folder are:

= Data — This folder contains the example Tools and Strategies
under their respective folders.

See Using the Electrode Machining Wizard (see page 6), Tooling
(see page 13), and Step 3 — Machining Strategies (see page 12)
for examples of how they are used.

= Models — This folder contains sample .trode and .psmodel files of
the electrodes.

* Videos — This folder contains videos, which demonstrate how to
use the Electrode Machining Wizard.
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Using the Electrode
Machining Wizard

The Electrode Machining Wizard guides you through the process of
creating electrodes. It includes several steps that:

= Set up the block (see page 9).

= Analyse and modify (see page 10) the Minimum radius and Draft
angle.

= Select from the previously created machining strategies (see
page 12).

= Select the machine tool (see page 13), if necessary.
= Perform final tasks (see page 14).

= QOrganise and process projects (see page 15) queued to the
PowerMill Project Server.

The following steps use the ForgingConnector example from
Electrode Machining Wizard examples (see page 5), and assumes
you have installed the file in the default installation location.
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To start the Electrode Machining Wizard, in PowerMill:

1 Click File tab > Import > Import Electrode. This displays the
Import Electrode dialog.

-
P Import Electrade

A=)

Trode file

Preview Mame

Output project

Accept

Cancel

L

&

2 In the Trode File area, click to display the Select Trode Archive
dialog.

3 Browse to C:\Program

Files\Autodesk\ElectrodeMachiningExamples13100\Models\Forging
Connector and select the electrode_data.trode file and click Open.

Autodesk PowerMill
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The available electrodes are listed in the Import Electrode dialog.
In this case, Teel.

i B
P Import Electrode &Iﬂj
Trodefile »rging Connector\electrode_data.trode

Preview Mame

Teel

Output project

L A

4 Select the electrode Tee 1.

5 In the Output project area, click and enter a new project
name and select the folder where you want to store the project.

6 Click Accept.

This imports the selected electrode into PowerMill with the HTML
tab displaying the electrode details.

This starts the Electrode Machining Wizard and takes you to the
Block Setup (see page 9) step of the wizard.
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Step 1 — Block Setup

Use the Block Setup page to define the size of the block that the
electrode is to be machined from.

r h'
P Electrode Wizard - Machining ﬁ
o Block Setup
'~
Blank Height 235759 @
Base Height 10,4259 .
[ MNext = ] Finish [ Cancel Help

L .J

Blank height — The height of the electrode machining material.

Base height — The height of the part base.

When you have made the necessary changes, click Next to go to the
Analysis (see page 10) page of the wizard. Click Finish if you want
to end the wizard after generating the electrode machining material.
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Step 2 — Analysis

Use the Analysis page to analyse and modify the Minimum radius
and Draft angle. The colours used to display the model represent the
radius and available draft angles.

[ P Electrode Wizard - Machining ﬁw
,;'é Analysis
Minimum Radius .
0 U 10
5
Draft Angle [+] -]
0 0 10
5
| <Back || Net> | | Fnsn | | Cancel | | Help |
L5

A

Use the sliders to increase or decrease the values. To make finer
adjustments, click [*J to increase or click E] to decrease the slider

factor.

After the initial analysis, click Next to go to the Machining Strategies
(see page 12) page. Click Finish if you want to end the wizard after

analysing the Minimum Radius and Draft Angle.

See also

Using PowerMill interactively with the Electrode Machining Wizard

(see page 11)
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Using PowerMill interactively with the Electrode
Machining Wizard

You can use PowerMill at the same time as you are using the
wizard.

For example, to find and measure an area on the model with a
minimum radius of less than 0.80 mm:

1 Move the Minimum Radius slider to display 0.80. This displays
areas on the model which have a minimum radius equal to or
below 0.80 mm.

[P Electrode Wizard - Machining =)
,_;I'{ Analysis
Minimum Radius .
0 ( 187
0.8
Draft Angle .
0 () 10
5
[ < Back l [ Next > ] [ Finish l [ Cancel ] [ Help ]
L A

I=C? Use |*] to increase or E] to decrease the slider measurement
granularity.

2 In PowerMill click Home tab > Utilities panel > Measurer to
display the Measure dialog.

Fest
3 On the Measure dialog, click |L| to measure a Radius from Three

Points. In the below example, this shows that the exact radius in
this region is 0.75 mm.

P Electrode Wizard - Machining

NG Analysis
e \

Minimum Radius
0 U 187
0.80
Draft Angle

0 { 10

5

<Back || MNew» | | Finsh | [ Cancel
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Step 3 — Machining Strategies

Use the Machining Strategies page to select the strategy used to
machine the electrode. You can also modify the undersizes loaded
from the .trode file.

In this example, Connector 16mm and RibTypel are previously
created Machining Strategies. When a previously created strategy is
selected, it imports the associated tools and toolpaths into the
current PowerMill session.

P Electrode Wizard - Machining @
‘o Machining Strategies

g

Undersizes
Rougher

Semi-Finisher

Finisher

[ < Back |[ MNext = | [ Finish | [ Cancel | [ Help |

Use Rougher, Semi-finisher, and Finisher fields to make changes to
Undersizes.

Click Reset to revert all values to their default.

Click Tooling to display the Tooling (see page 13) step. The step
enables you to load additional tools to the electrode project so a
tooling gap within the machining strategy can be filled. (A tooling
gap may occur if you are using a machining strategy to machine an
electrode that the strategy was not designed for.)

Click Next to move to the Final Tasks (see page 14) page of the
wizard. Click Finish if you want to end the wizard at loading the
machining strategies step.

See also
Configuring the Electrode Machining Wizard (see page 19)
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Tooling

Use the Tooling page to load additional tools to the electrode project
so a tooling gap within the machining strategy can be filled. (A
tooling gap may occur if you are using a machining strategy to
machine an electrode that the strategy was not designed for.)

To display the Tooling page, click the Tooling button on the
Machining Strategies page.

[ P Electrode Wizard - Machining @‘
Tooling
Haas Mini Mill Roders RFMAOD
I < Back ‘ ‘ Next > ’ | Finish | I Cancel ’ | Help ’
&  The displayed machine tools are dependent on your machine

tool installations.

Select the machine tool you want. The machine tool is displayed

with a .

[ P Electrode Wizard - Machining lﬁ‘
Tooling
Haas Mini Mill Roders RFM600
[ < Back | [ Next > I | Finish | | Cancel ’ ‘ Help ’
-

s

Selecting a machine tool loads the associated tools into the

PowerMill session.

O

If you want to just import the tools saved with the toolpath

templates, click Next without selecting a machine tool.

Autodesk PowerMill
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After selecting the machine tool, click Next to open the Machining
Strategies (see page 12) page of the wizard. Click Finish if you want
to end the wizard after importing the tools into the current
PowerMill session.

See also

Configuring the Electrode Machining Wizard (see page 19)

Step 4 — Final Tasks

Use the Final Tasks page to create boundaries for the electrode
regions, to make or read notes about the machining strategy, and
to specify when the project is to be processed.

P Electrode Wizard - Machining &J

Final Tasks

L
.
Create | Create burn region boundary
Create | Create burn and clearance region boundary
Create | Create matenal black boundary MNotes |

[T] Queue to PowerMil Project Server

Transparency
0 100
50
< Back | [ Finish | [ Cancel | [ Help |

Create burn region boundary — Click to create a boundary around the
burn region (displayed in red).

Create burn and clearance region boundary — Click to create a
boundary around the burn and clearance regions (displayed in red
and green respectively).

Create material block boundary — Click to create a boundary around
the block region (displayed in green).

Transparency — Move the slider to adjust the transparency of the
electrode.

Notes — Click to open WordPad. The function provides an easy
method to record information about the strategy setup for future
use. The file is saved in the relevant machining strategy folder and
can be viewed and updated by clicking Notes.
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Queue to PowerMill Project Server — Select and then click Finish to
add the project to the PowerMill Project Server. This enables you to
calculate the project, and any other queued projects, using a
second session of PowerMill so you can continue to work in
PowerMill uninterrupted. Using the server also enables you to
process the projects at a more convenient time, such as during the
evening, when CPU performance is not such a concern.

Finish — Click to calculate the project. To calculate the project at a
later time, select the Queue to PowerMill Project Server option.

PowerMill Project Server

Use the PowerMill Project Server to organise and process queued
projects.

To display the server, select the Queue to PowerMill Project Server
option on the Final Tasks (see page 14) page of the wizard and click
Finish, or double-click the server's desktop icon.

P PowerMill Project Server =8
Project Macro Progress Error Message
. prajs frame_level_batch Complete El
. prajd rib_typel_batch Failed Toclpath not calculated
] rib_typel_batch Precessing
Ly —— -
testl Pending
9 ch Pendimg
10 Ty ch Pending |é
5 Pending @
projd ch Pending
od £h Pending
=

e

[][=)

> d @

The server has these main features:

= As well as adding projects to the server using the wizard, you
can also add projects directly to the server from your PC or
network.

= Projects are listed in the order they are queued to the server but
you can reorder the projects.

= The server enables you to assign or change a project's macro
(machining strategy).
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= To process the projects, the server uses its own PowerMill
session so you can continue to work in your current PowerMill
session without interruption.

= The project server shows the status of a project:
— Project currently being processed.
® — Project successfully processed.
® — Project unsuccessfully processed.

= If a project fails to be processed, the cause of the failure is
displayed in the Error column and the server continues to process
the next project. If you want to correct the error immediately,
you can stop the server and open the project in PowerMill. You
can then refresh the project and reprocess it.

= When you stop the processing of projects, the server maintains
its position so, when restarted, processing continues from where
it was stopped. The queue and the server position are also
maintained across sessions.

= For a project to be processed successfully, the toolpaths must be
free of collisions and gouges, and the project must be processed
fully. If necessary, you can load a custom validation macro with
different and/or extra criteria to check the projects against. For
more information about validation macros, see Options (see page
18).

The server features the following options:

@| Add — Click to add a project or a folder of projects to the queue.
The server ignores any duplicates.

=| Remove — Click to remove selected projects from the queue.

) Refresh — Click to update the project after making changes to it
in PowerMill.

@| Move up — Click to move the selected project up in the queue.

E| Move down — Click to move the selected project down in the
gueue.

=) Options — Click to display the PowerMill Project Server Options
(see page 18) dialog.

%] set macro — Click to display the macro file that is assigned to the
selected project. This enables you to change or specify the macro
(machining strategy) for a project.

©] pisplay help — Click to display help.

9] About — Click to display version information.
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IL‘ Start — Click to start calculating projects.

Lg‘ Stop — Click to stop calculating projects. The server maintains
its position and restarts in the same place. The queue and the
server position are maintained across sessions.

@‘ Open — Click to open the selected project in PowerMill. This is
useful if you need to fix an error that caused the processing of
project to fail.
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PowerMill Project Server Options dialog

Use the PowerMill Project Server Options dialog to customise the
server.

To display the dialog, click Options =) on the PowerMill Project Server
dialog.

P PowerMill Project Server Options =N X

[T Automatically process queued projects

Validation
Mene
@ Default toolpath validation

Validation macro

CA\Program Files\ Autodesk\PowerMilProjectServer14100\Macros\vi

Processing

Timeout for attempting to process locked projects: 13 seconds

OK | Cancel |

The validation options enable you to set the criteria used to assess
whether a project is considered safe to be machined and, therefore,
if the project is processed successfully or not.

18 « Using the Electrode Machining Wizard

None — Select this option if you do not want to check projects.

Default toolpath validation — Select this option to use the server's
default validation criteria, which checks that toolpaths are free
from collisions and gouges and the project has been processed
fully.

Validation macro — Select this option to use your own validation
macro.

Automatically process queued projects — Select this option to
automatically process projects that are queued to the server.

Timeout for attempting to process locked projects — Specify how
long the server waits before trying to process the project again.
This enables you to close the project in PowerMill because if the
project is open then it cannot be processed.

Reference Help



Configuring the Electrode
Machining Wizard

The tools and strategies available on the Tooling and Machining
Strategies steps of the Electrode Machining Wizard are available in
their respective folders under the Data folder as specified in File tab
> Options > Manage Installed Plugins > Electrode Wizard > Options (see
page 22).

To create machine tools, see Creating machine tools for the
Electrode Machining Wizard (see page 20).

To create machining strategies, see Creating machining strategies
for the Electrode Machining Wizard (see page 20).
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Creating machine tools for the
Electrode Machining Wizard

To define the tools available at the Tooling (see page 13) stage of
the wizard:

1 In an empty PowerMill project, create the tools available in your
machine tool carousel.

2 Click File tab > Save As > Template objects to create a PowerMill
template (.ptf) file and name it appropriately.

3 Create an image of your machine tool in a .png format file and
name it appropriately.
-0 You can also use a Jpg format image file as the machine
tool image.

4 Create a folder in the name of your machine tool under the Tools
folder defined in the Electrode Machining Wizard Options (see
page 22) dialog.

5 Copy both the .ptf and .png files to the machine tool folder.

You can view these machine tools in the Tooling (see page 13) step
of the wizard.

Creating machining strategies for the
Electrode Machining Wizard

The main points to remember while creating machining strategies
for Electrode Machining Wizard are:

= Remove any undersizes. Toolpaths must only have the
machining allowances applied to them.

* You must save any surfaces, which must be selected before
the toolpath is calculated, on the toolpath component
thickness set 7.

= Toolpaths cannot be calculated if the spark gaps of the
electrode plus the machining tolerance is greater than the tool
radius. However, for toolpaths using end mills and slot drills,
toolpaths are calculated but require visual verification.

= If you need a boundary for your toolpath, create an empty
boundary and save the required parameters to a macro. Then,
run the xxx_batch.mac to automatically apply these
parameters.
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=& You can give the macro any name you want, but the file
name has to end with batch.mac. For example, if you want
to name your macro Fred, then the complete file name
must be Fred_batch.mac.

1 Create a PowerMill toolpath for the electrode you want to
machine.

2 Right-click the toolpath and select Save as template.

3 In the Template Parameter Saving dialog, enter the toolpath name
and select the folder where you want to save the template.

L)  You can control the order in which the toolpath templates are
imported by adding a numeric value at the beginning of the
template name. For example, 01_firsttoolpath.ptf,
02_secondtoolpath. ptf.

1 Click Save. This saves a PowerMill template file (.ptf) with the
toolpath details.

2 Create an image of your electrode in a .png format file and name
it appropriately. Save the image in the same folder as the
PowerMill template.

) You can also use a Jpg format file.

3 Copy the xxx_batch.mac file from the install directory and copy it
into the same folder as the template.

The macro checks the model for surfaces to be selected. These
are surfaces which are defined at the component thickness set 7.

When you prepare the electrode to be machined, using the
Component Thickness dialog, place the surfaces you need to
select in component thickness set 7. If there are no surfaces to
select, then the levels are ignored and the macro machines the
whole model.

&  The xxx_batch.mac file contains commands in the PowerMill
macro programming language; therefore, you can add
additional commands to customise the macro for each
individual electrode. Refer to the PowerMill Macro guide for
more details.

=&  For more details on adding surfaces to a particular

component thickness set, see the 'Assigning thickness
values' topic in the PowerMill help file.
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Changing the Electrode Machining

Wizard options

1 In PowerMill, click File tab > Options > Manage Installed Plugins

to display the Plugin Manager.
2 Select Electrode Wizard.

-
P Plugin Manager

L2 [ |

Status  Plugin name

Electrode Wizard

i‘ Electrode Wizard

Status:
Enabled

Version:
1.0.4593

Author:
Autodesk

Description:
A plugin allowing easy setup of
electrode projects

MET Runtime Version:
vl 0.30319

Class 1D:
{8B9A0CE4-FCI3-44DC-ABEA-
I178A010708E]}

Enableall || Disableall |

Plugin Path:

m

| Disable || Options

"
o
et
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3 Click Options to display the Electrode Plugin Options dialog.
( [ Electrode Plugin Options ﬁw

Data directory Ch\Program Files\Autodes E|

Automatically remeove duplicate entities

[ Accept |[ Cancel |

L -~

= Datadirectory — Specifies where the data (the tools and
strategies) are stored. By default, this is the plugin installation
directory:

C:\Program Files\Autodesk\ElectrodeMachiningWizardxxxxx\Data

where xxxxx is the Electrode Machining Wizard version
number.

= Automatically remove duplicate entries — When this check box
is selected, duplicate tooling is removed from imported
strategies. Deselect the check box to retain duplicate tooling.

4 When you have made the changes, click Accept on the Electrode
Plugin Options dialog to apply them.

5 On the Plugin Manager, click OK to close it.
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Autodesk Legal Notice

© 2021 Autodesk, Inc. All Rights Reserved. Except where otherwise
noted, this work is licensed under a Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License that can be
viewed online at http://creativecommons.org/licenses/by-nc-
sa/3.0/. This license content, applicable as of 16 December 2014 to
this software product, is reproduced here for offline users:

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND
DOES NOT PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS
LICENSE DOES NOT CREATE AN ATTORNEY-CLIENT RELATIONSHIP.
CREATIVE COMMONS PROVIDES THIS INFORMATION ON AN "AS-
IS" BASIS. CREATIVE COMMONS MAKES NO WARRANTIES
REGARDING THE INFORMATION PROVIDED, AND DISCLAIMS
LIABILITY FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS
OF THIS CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR
"LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT AND/OR
OTHER APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS
AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS
PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU
ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS
LICENSE. TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO
BE A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS
CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF
SUCH TERMS AND CONDITIONS.
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1. Definitions

a. "Adaptation” means a work based upon the Work, or upon the
Work and other pre-existing works, such as a translation,
adaptation, derivative work, arrangement of music or other
alterations of a literary or artistic work, or phonogram or
performance and includes cinematographic adaptations or any other
form in which the Work may be recast, transformed, or adapted
including in any form recognizably derived from the original, except
that a work that constitutes a Collection will not be considered an
Adaptation for the purpose of this License. For the avoidance of
doubt, where the Work is a musical work, performance or
phonogram, the synchronization of the Work in timed-relation with
a moving image ("synching") will be considered an Adaptation for
the purpose of this License.

b. "Collection" means a collection of literary or artistic works, such
as encyclopedias and anthologies, or performances, phonograms or
broadcasts, or other works or subject matter other than works listed
in Section 1(g) below, which, by reason of the selection and
arrangement of their contents, constitute intellectual creations, in
which the Work is included in its entirety in unmodified form along
with one or more other contributions, each constituting separate
and independent works in themselves, which together are
assembled into a collective whole. A work that constitutes a
Collection will not be considered an Adaptation (as defined above)
for the purposes of this License.

c. "Distribute"” means to make available to the public the original
and copies of the Work or Adaptation, as appropriate, through sale
or other transfer of ownership.

d. "License Elements" means the following high-level license
attributes as selected by Licensor and indicated in the title of this
License: Attribution, Noncommercial, ShareAlike.

e. "Licensor" means the individual, individuals, entity or entities
that offer(s) the Work under the terms of this License.

f. "Original Author" means, in the case of a literary or artistic work,
the individual, individuals, entity or entities who created the Work
or if no individual or entity can be identified, the publisher; and in
addition (i) in the case of a performance the actors, singers,
musicians, dancers, and other persons who act, sing, deliver,
declaim, play in, interpret or otherwise perform literary or artistic
works or expressions of folklore; (ii) in the case of a phonogram the
producer being the person or legal entity who first fixes the sounds
of a performance or other sounds; and, (iii) in the case of
broadcasts, the organization that transmits the broadcast.
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g. "Work" means the literary and/or artistic work offered under the
terms of this License including without limitation any production in
the literary, scientific and artistic domain, whatever may be the
mode or form of its expression including digital form, such as a
book, pamphlet and other writing; a lecture, address, sermon or
other work of the same nature; a dramatic or dramatico-musical
work; a choreographic work or entertainment in dumb show; a
musical composition with or without words; a cinematographic work
to which are assimilated works expressed by a process analogous to
cinematography; a work of drawing, painting, architecture,
sculpture, engraving or lithography; a photographic work to which
are assimilated works expressed by a process analogous to
photography; a work of applied art; an illustration, map, plan,
sketch or three-dimensional work relative to geography,
topography, architecture or science; a performance; a broadcast; a
phonogram; a compilation of data to the extent it is protected as a
copyrightable work; or a work performed by a variety or circus
performer to the extent it is not otherwise considered a literary or
artistic work.

h. "You" means an individual or entity exercising rights under this
License who has not previously violated the terms of this License
with respect to the Work, or who has received express permission
from the Licensor to exercise rights under this License despite a
previous violation.

i. "Publicly Perform" means to perform public recitations of the Work
and to communicate to the public those public recitations, by any
means or process, including by wire or wireless means or public
digital performances; to make available to the public Works in such
a way that members of the public may access these Works from a
place and at a place individually chosen by them; to perform the
Work to the public by any means or process and the communication
to the public of the performances of the Work, including by public
digital performance; to broadcast and rebroadcast the Work by any
means including signs, sounds or images.

j. "Reproduce" means to make copies of the Work by any means
including without limitation by sound or visual recordings and the
right of fixation and reproducing fixations of the Work, including
storage of a protected performance or phonogram in digital form or
other electronic medium.

2. Fair Dealing Rights. Nothing in this License is intended to reduce,
limit, or restrict any uses free from copyright or rights arising from
limitations or exceptions that are provided for in connection with the
copyright protection under copyright law or other applicable laws.
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3. License Grant. Subject to the terms and conditions of this License,
Licensor hereby grants You a worldwide, royalty-free, non-
exclusive, perpetual (for the duration of the applicable copyright)
license to exercise the rights in the Work as stated below:

a. to Reproduce the Work, to incorporate the Work into one or
more Collections, and to Reproduce the Work as incorporated in
the Collections;

b. to create and Reproduce Adaptations provided that any such
Adaptation, including any translation in any medium, takes
reasonable steps to clearly label, demarcate or otherwise identify
that changes were made to the original Work. For example, a
translation could be marked "The original work was translated
from English to Spanish," or a modification could indicate "The
original work has been modified.";

c. to Distribute and Publicly Perform the Work including as
incorporated in Collections; and,

d. to Distribute and Publicly Perform Adaptations.

The above rights may be exercised in all media and formats
whether now known or hereafter devised. The above rights include
the right to make such modifications as are technically necessary to
exercise the rights in other media and formats. Subject to Section
8(f), all rights not expressly granted by Licensor are hereby
reserved, including but not limited to the rights described in Section
4(e).
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4. Restrictions. The license granted in Section 3 above is expressly
made subject to and limited by the following restrictions:

a. You may Distribute or Publicly Perform the Work only under
the terms of this License. You must include a copy of, or the
Uniform Resource Identifier (URI) for, this License with every
copy of the Work You Distribute or Publicly Perform. You may not
offer or impose any terms on the Work that restrict the terms of
this License or the ability of the recipient of the Work to exercise
the rights granted to that recipient under the terms of the
License. You may not sublicense the Work. You must keep intact
all notices that refer to this License and to the disclaimer of
warranties with every copy of the Work You Distribute or Publicly
Perform. When You Distribute or Publicly Perform the Work, You
may not impose any effective technological measures on the
Work that restrict the ability of a recipient of the Work from You
to exercise the rights granted to that recipient under the terms of
the License. This Section 4(a) applies to the Work as
incorporated in a Collection, but this does not require the
Collection apart from the Work itself to be made subject to the
terms of this License. If You create a Collection, upon notice from
any Licensor You must, to the extent practicable, remove from
the Collection any credit as required by Section 4(d), as
requested. If You create an Adaptation, upon notice from any
Licensor You must, to the extent practicable, remove from the
Adaptation any credit as required by Section 4(d), as requested.
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b. You may Distribute or Publicly Perform an Adaptation only
under: (i) the terms of this License; (ii) a later version of this
License with the same License Elements as this License; (iii) a
Creative Commons jurisdiction license (either this or a later
license version) that contains the same License Elements as this
License (e.g., Attribution-NonCommercial-ShareAlike 3.0 US)
("Applicable License"). You must include a copy of, or the URI,
for Applicable License with every copy of each Adaptation You
Distribute or Publicly Perform. You may not offer or impose any
terms on the Adaptation that restrict the terms of the Applicable
License or the ability of the recipient of the Adaptation to
exercise the rights granted to that recipient under the terms of
the Applicable License. You must keep intact all notices that refer
to the Applicable License and to the disclaimer of warranties with
every copy of the Work as included in the Adaptation You
Distribute or Publicly Perform. When You Distribute or Publicly
Perform the Adaptation, You may not impose any effective
technological measures on the Adaptation that restrict the ability
of a recipient of the Adaptation from You to exercise the rights
granted to that recipient under the terms of the Applicable
License. This Section 4(b) applies to the Adaptation as
incorporated in a Collection, but this does not require the
Collection apart from the Adaptation itself to be made subject to
the terms of the Applicable License.

c. You may not exercise any of the rights granted to You in
Section 3 above in any manner that is primarily intended for or
directed toward commercial advantage or private monetary
compensation. The exchange of the Work for other copyrighted
works by means of digital file-sharing or otherwise shall not be
considered to be intended for or directed toward commercial
advantage or private monetary compensation, provided there is
no payment of any monetary compensation in connection with
the exchange of copyrighted works.
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d. If You Distribute, or Publicly Perform the Work or any
Adaptations or Collections, You must, unless a request has been
made pursuant to Section 4(a), keep intact all copyright notices
for the Work and provide, reasonable to the medium or means
You are utilizing: (i) the name of the Original Author (or
pseudonym, if applicable) if supplied, and/or if the Original
Author and/or Licensor designate another party or parties (e.g.,
a sponsor institute, publishing entity, journal) for attribution
("Attribution Parties") in Licensor's copyright notice, terms of
service or by other reasonable means, the name of such party or
parties; (ii) the title of the Work if supplied; (iii) to the extent
reasonably practicable, the URI, if any, that Licensor specifies to
be associated with the Work, unless such URI does not refer to
the copyright notice or licensing information for the Work; and,
(iv) consistent with Section 3(b), in the case of an Adaptation, a
credit identifying the use of the Work in the Adaptation (e.g.,
"French translation of the Work by Original Author," or
"Screenplay based on original Work by Original Author"). The
credit required by this Section 4(d) may be implemented in any
reasonable manner; provided, however, that in the case of a
Adaptation or Collection, at a minimum such credit will appear, if
a credit for all contributing authors of the Adaptation or
Collection appears, then as part of these credits and in a manner
at least as prominent as the credits for the other contributing
authors. For the avoidance of doubt, You may only use the credit
required by this Section for the purpose of attribution in the
manner set out above and, by exercising Your rights under this
License, You may not implicitly or explicitly assert or imply any
connection with, sponsorship or endorsement by the Original
Author, Licensor and/or Attribution Parties, as appropriate, of
You or Your use of the Work, without the separate, express prior
written permission of the Original Author, Licensor and/or
Attribution Parties.

e. For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those
jurisdictions in which the right to collect royalties through any
statutory or compulsory licensing scheme cannot be waived,
the Licensor reserves the exclusive right to collect such
royalties for any exercise by You of the rights granted under
this License;
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ii. Waivable Compulsory License Schemes. In those
jurisdictions in which the right to collect royalties through any
statutory or compulsory licensing scheme can be waived, the
Licensor reserves the exclusive right to collect such royalties
for any exercise by You of the rights granted under this
License if Your exercise of such rights is for a purpose or use
which is otherwise than noncommercial as permitted under
Section 4(c) and otherwise waives the right to collect royalties
through any statutory or compulsory licensing scheme; and,

iii. Voluntary License Schemes. The Licensor reserves the right
to collect royalties, whether individually or, in the event that
the Licensor is a member of a collecting society that
administers voluntary licensing schemes, via that society,
from any exercise by You of the rights granted under this
License that is for a purpose or use which is otherwise than
noncommercial as permitted under Section 4(c).

f. Except as otherwise agreed in writing by the Licensor or as
may be otherwise permitted by applicable law, if You Reproduce,
Distribute or Publicly Perform the Work either by itself or as part
of any Adaptations or Collections, You must not distort, mutilate,
modify or take other derogatory action in relation to the Work
which would be prejudicial to the Original Author's honor or
reputation. Licensor agrees that in those jurisdictions (e.g.
Japan), in which any exercise of the right granted in Section 3(b)
of this License (the right to make Adaptations) would be deemed
to be a distortion, mutilation, modification or other derogatory
action prejudicial to the Original Author's honor and reputation,
the Licensor will waive or not assert, as appropriate, this Section,
to the fullest extent permitted by the applicable national law, to
enable You to reasonably exercise Your right under Section 3(b)
of this License (right to make Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN
WRITING AND TO THE FULLEST EXTENT PERMITTED BY APPLICABLE
LAW, LICENSOR OFFERS THE WORK AS-IS AND MAKES NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND CONCERNING
THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE,
INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER
DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS,
WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THIS
EXCLUSION MAY NOT APPLY TO YOU.
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6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY
APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU
ON ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL,
CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING
OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

7. Termination

a. This License and the rights granted hereunder will terminate
automatically upon any breach by You of the terms of this
License. Individuals or entities who have received Adaptations or
Collections from You under this License, however, will not have
their licenses terminated provided such individuals or entities
remain in full compliance with those licenses. Sections 1, 2, 5, 6,
7, and 8 will survive any termination of this License.

b. Subject to the above terms and conditions, the license granted
here is perpetual (for the duration of the applicable copyright in
the Work). Notwithstanding the above, Licensor reserves the
right to release the Work under different license terms or to stop
distributing the Work at any time; provided, however that any
such election will not serve to withdraw this License (or any
other license that has been, or is required to be, granted under
the terms of this License), and this License will continue in full
force and effect unless terminated as stated above.

8. Miscellaneous

a. Each time You Distribute or Publicly Perform the Work or a
Collection, the Licensor offers to the recipient a license to the
Work on the same terms and conditions as the license granted to
You under this License.

b. Each time You Distribute or Publicly Perform an Adaptation,
Licensor offers to the recipient a license to the original Work on
the same terms and conditions as the license granted to You
under this License.

c. If any provision of this License is invalid or unenforceable
under applicable law, it shall not affect the validity or
enforceability of the remainder of the terms of this License, and
without further action by the parties to this agreement, such
provision shall be reformed to the minimum extent necessary to
make such provision valid and enforceable.

d. No term or provision of this License shall be deemed waived
and no breach consented to unless such waiver or consent shall
be in writing and signed by the party to be charged with such
waiver or consent.
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e. This License constitutes the entire agreement between the
parties with respect to the Work licensed here. There are no
understandings, agreements or representations with respect to
the Work not specified here. Licensor shall not be bound by any
additional provisions that may appear in any communication
from You. This License may not be modified without the mutual
written agreement of the Licensor and You.

f. The rights granted under, and the subject matter referenced,
in this License were drafted utilizing the terminology of the Berne
Convention for the Protection of Literary and Artistic Works (as
amended on September 28, 1979), the Rome Convention of
1961, the WIPO Copyright Treaty of 1996, the WIPO
Performances and Phonograms Treaty of 1996 and the Universal
Copyright Convention (as revised on July 24, 1971). These rights
and subject matter take effect in the relevant jurisdiction in
which the License terms are sought to be enforced according to
the corresponding provisions of the implementation of those
treaty provisions in the applicable national law. If the standard
suite of rights granted under applicable copyright law includes
additional rights not granted under this License, such additional
rights are deemed to be included in the License; this License is
not intended to restrict the license of any rights under applicable
law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no
warranty whatsoever in connection with the Work. Creative
Commons will not be liable to You or any party on any legal theory
for any damages whatsoever, including without limitation any
general, special, incidental or consequential damages arising in
connection to this license. Notwithstanding the foregoing two (2)
sentences, if Creative Commons has expressly identified itself as
the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the
Work is licensed under the CCPL, Creative Commons does not
authorize the use by either party of the trademark "Creative
Commons" or any related trademark or logo of Creative Commons
without the prior written consent of Creative Commons. Any
permitted use will be in compliance with Creative Commons' then-
current trademark usage guidelines, as may be published on its
website or otherwise made available upon request from time to
time. For the avoidance of doubt, this trademark restriction does
not form part of this License.

Creative Commons may be contacted at
http://creativecommons.org/.
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Certain materials included in this publication are reprinted with the
permission of the copyright holder.

Creative Commons FAQ

Autodesk's Creative Commons FAQ can be viewed online at
https://knowledge.autodesk.com/customer-service/share-the-
knowledge, and is reproduced here for offline users.

Creative Commons is a simple, open licensing model which allows
individuals to freely modify, remix, and share digital content created
for learning and support.

Borrow from the Autodesk Learning, Support and Video libraries to
build a new learning experience for anyone with any particular need
or interest. It's out there. You can use it. It's yours.

In collaboration with Creative Commons, Autodesk invites you to
share your knowledge with the rest of the world, inspiring others to
learn, achieve goals, and ignite creativity.

What is Creative Commons?

Creative Commons (CC) is a nonprofit organization that offers a
simple licensing model that frees digital content to enable anyone to
modify, remix, and share creative works.

How do | know if Autodesk learning content and Autodesk University
content is available under Creative Commons?

All Autodesk learning content and Autodesk University content
released under Creative Commons is explicitly marked with a
Creative Commons icon specifying what you can and cannot do.
Always follow the terms of the stated license.

What Autodesk learning content is currently available under Creative
Commons?

Over time, Autodesk will release more and more learning content
under the Creative Commons licenses.

Currently available learning content:

= Autodesk online help-Online help for many Autodesk products,
including its embedded media such as images and help movies.

= Autodesk Learning Videos-A range of video-based learning
content, including the video tutorials on the Autodesk YouTube™
Learning Channels and their associated iTunes® podcasts.

= Autodesk downloadable materials-Downloadable 3D assets,
digital footage, and other files you can use to follow along on
your own time.
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Is Autodesk learning and support content copyrighted?

Yes. Creative Commons licensing does not replace copyright.
Copyright remains with Autodesk or its suppliers, as applicable. But
it makes the terms of use much more flexible.

What do the Autodesk Creative Commons licenses allow?

Autodesk makes some of its learning and support content available
under two distinct Creative Commons licenses. The learning content
is clearly marked with the applicable Creative Commons license.
You must comply with the following conditions:

= Attribution-NonCommercial-ShareAlike (CC BY-NC-SA) This license
lets you copy, distribute, display, remix, tweak, and build upon
our work noncommercially, as long as you credit Autodesk and
license your new creations under the identical terms. Terms of
this license can be viewed online at
https://creativecommons.org/licenses/by-nc-sa/3.0/us/

= Attribution-NonCommercial-No Derivative Works (CC BY-NC-ND)
This license lets you copy, distribute, and display only verbatim
copies of our work as long as you credit us, but you cannot alter
the learning content in any way or use it commercially. Terms of
this license can be viewed online at
https://creativecommons.org/licenses/by-nc-
nd/3.0/us/deed.en_US

= Special permissions on content marked as No Derivative Works For
video-based learning content marked as No Derivative Works
(ND), Autodesk grants you special permission to make
modifications but only for the purpose of translating the video
content into another language.

These conditions can be modified only by explicit permission of
Autodesk, Inc. Send requests for modifications outside of these
license terms to creativecommons@autodesk.com.

Can | get special permission to do something different with the learning
content?

Unless otherwise stated, our Creative Commons conditions can be
modified only by explicit permission of Autodesk, Inc. If you have
any questions or requests for modifications outside of these license
terms, email us at creativecommons@autodesk.com.
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How do | attribute Autodesk learning content?

You must explicitly credit Autodesk, Inc., as the original source of
the materials. This is a standard requirement of the Attribution (BY)
term in all Creative Commons licenses. In some cases, such as for
the Autodesk video learning content, we specify exactly how we
would like to be attributed.

This is usually described on the video's end-plate. For the most part
providing the title of the work, the URL where the work is hosted,
and a credit to Autodesk, Inc., is quite acceptable. Also, remember
to keep intact any copyright notice associated with the work. This
may sound like a lot of information, but there is flexibility in the way
you present it.

Here are some examples:

"This document contains content adapted from the Autodesk®
Maya® Help, available under a Creative Commons Attribution-
NonCommercial-Share Alike license. Copyright © Autodesk, Inc."

"This is a Finnish translation of a video created by the Autodesk
Maya Learning Channel @ www.youtube.com/mayahowtos.
Copyright © Autodesk, Inc."

"Special thanks to the Autodesk® 3ds Max® Learning Channel @
www.youtube.com/3dsmaxhowtos. Copyright © Autodesk, Inc."

Do | follow YouTube's standard license or Autodesk's Creative
Commons license?

The videos of the Autodesk Learning Channels on YouTube are
uploaded under YouTube's standard license policy. Nonetheless,
these videos are released by Autodesk as Creative Commons
Attribution-NonCommercial-No Derivative Works (CC BY-NC-ND)
and are marked as such.

You are free to use our video learning content according to the
Creative Commons license under which they are released.
Where can | easily download Autodesk learning videos?

Most of the Autodesk Learning Channels have an associated iTunes
podcast from where you can download the same videos and watch
them offline. When translating Autodesk learning videos, we
recommend downloading the videos from the iTunes podcasts.
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Can | translate Autodesk learning videos?

Yes. Even though our learning videos are licensed as No Derivative
Works (ND), we grant everyone permission to translate the audio
and subtitles into other languages. In fact, if you want to recapture
the video tutorial as-is but show the user interface in another
language, you are free to do so. Be sure to give proper attribution
as indicated on the video's Creative Commons end-plate. This
special permission only applies to translation projects. Requests for
modifications outside of these license terms can be directed to
creativecommons@autodesk.com.

How do | let others know that | have translated Autodesk learning
content into another language?

Autodesk is happy to see its learning content translated into as
many different languages as possible. If you translate our videos or
any of our learning content into other languages, let us know. We
can help promote your contributions to our growing multilingual
community. In fact, we encourage you to find creative ways to
share our learning content with your friends, family, students,
colleagues, and communities around the world. Contact us at
creativecommons@autodesk.com.

| have translated Autodesk learning videos into other languages. Can |
upload them to my own YouTube channel?

Yes, please do and let us know where to find them so that we can
help promote your contributions to our growing multilingual
Autodesk community. Contact us at
creativecommons@autodesk.com.

Can | repost or republish Autodesk learning content on my site or blog?

Yes, you can make Autodesk learning material available on your site
or blog as long as you follow the terms of the Creative Commons
license under which the learning content is released. If you are
simply referencing the learning content as-is, then we recommend
that you link to it or embed it from where it is hosted by Autodesk.
That way the content will always be fresh. If you have translated or
remixed our learning content, then by all means you can host it
yourself. Let us know about it, and we can help promote your
contributions to our global learning community. Contact us at
creativecommons@autodesk.com.
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Can | show Autodesk learning content during my conference?

Yes, as long as it's within the scope of a noncommercial event, and
as long as you comply with the terms of the Creative Commons
license outlined above. In particular, the videos must be shown
unedited with the exception of modifications for the purpose of
translation. If you wish to use Autodesk learning content in a
commercial context, contact us with a request for permission at
creativecommons@autodesk.com.

Can | use Autodesk learning content in my classroom?

Yes, as long as you comply with the terms of the Creative Commons
license under which the learning material is released. Many teachers
use Autodesk learning content to stimulate discussions with
students or to complement course materials, and we encourage you
to do so as well.

Can | re-edit and remix Autodesk video learning content?

No, but for one exception. Our Creative Commons BY-NC-ND license
clearly states that "derivative works" of any kind (edits, cuts,
remixes, mashups, and so on) are not allowed without explicit
permission from Autodesk. This is essential for preserving the
integrity of our instructors' ideas. However, we do give you
permission to modify our videos for the purpose of translating them
into other languages.

Can I re-edit and remix Autodesk downloadable 3D assets and footage?

Yes. The Autodesk Learning Channels on YouTube provide
downloadable 3D assets, footage, and other files for you to follow
along with the video tutorials on your own time. This downloadable
material is made available under a Creative Commons Attribution-
NonCommercial-ShareAlike (CC BY-NC-SA) license. You can
download these materials and experiment with them, but your
remixes must give us credit as the original source of the content
and be shared under the identical license terms.

Can | use content from Autodesk online help to create new materials for
a specific audience?

Yes, if you want to help a specific audience learn how to optimize
the use of their Autodesk software, there is no need to start from
scratch. You can use, remix, or enrich the relevant help content and
include it in your book, instructions, examples, or workflows you
create, then Share-Alike with the community. Always be sure to
comply with the terms of the Creative Commons license under
which the learning content is released.
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What are the best practices for marking content with Creative Commons
Licenses?

When reusing a CC-licensed work (by sharing the original or a
derivative based on the original), it is important to keep intact any
copyright notice associated with the work, including the Creative
Commons license being used. Make sure you abide by the license
conditions provided by the licensor, in this case Autodesk, Inc.

Trademarks

The following are registered trademarks or trademarks of Autodesk,
Inc., and/or its subsidiaries and/or affiliates in the USA and other
countries: 123D, 3ds Max, ADSK, Alias, ArtCAM, ATC, AutoCAD LT,
AutoCAD, Autodesk, the Autodesk logo, Autodesk 123D, Autodesk
Alias, Autodesk Forge, Autodesk Fusion, Autodesk Inventor,
AutoSnap, BIM 360, Buzzsaw, CADmep, CAMduct, Civil 3D,
Configurator 360, Dancing Baby (image), DWF, DWG, DWG
(design/logo), DWG Extreme, DWG TrueConvert, DWG TrueView,
DWGX, DXF, Eagle, ESTmep, FBX, FeatureCAM, Flame, FormIt 360,
Fusion 360, The Future of Making Things, Glue, Green Building
Studio, InfraWorks, Instructables, Instructables (stylized robot
design/logo), Inventor, Inventor HSM, Inventor LT, Make Anything,
Maya, Maya LT, Moldflow, MotionBuilder, Mudbox, Navisworks,
Netfabb, Opticore, PartMaker, Pier 9, Powerlnspect, PowerMill,
PowerShape, Publisher 360, RasterDWG, RealDWG, ReCap, ReCap
360, Remake, Revit LT, Revit, Scaleform, Shotgun, Showcase,
Showcase 360, SketchBook, Softimage, Tinkercad, TrustedDWG,
VRED.

All other brand names, product names or trademarks belong to their
respective holders.

Disclaimer

THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS
MADE AVAILABLE BY AUTODESK, INC. "AS IS." AUTODESK, INC.
DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE
REGARDING THESE MATERIALS.

L@w Except where otherwise noted, this work is licensed

under a Creative Commons Attribution-NonCommercial-ShareAlike
3.0 Unported License. Please see the Autodesk Creative Commons
FAQ for more information.
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